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Preface

Intended Audience
Welcome to Release 11i of Oracle’s Knowledge Management.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle’s Knowledge Management

If you have never used Oracle’s Knowledge Management, Oracle suggests you 
attend one or more of the Oracle’s Knowledge Management training classes 
available through Oracle University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle’s 
Knowledge Management.

■ Chapter 1 provides an overview of Oracle’s Knowledge Management, key 
features, integrations with other Oracle applications, process flows, what’s new, 
and what’s obsolete sections.

■ Chapter 2 provides steps on how to access Oracle’s Knowledge Management 
and a summary of tasks that can be done in the module.
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■ Chapter 3 covers the search functionality of Oracle’s Knowledge Management 
and includes information and steps on accessing the different search methods.

■ Chapter 4 provides an overview of solutions and other tasks associated with 
solutions in the module.

■ Chapter 5 provides an overview of solution types and the tasks associated with 
solution types in Oracle’s Knowledge Management.

■ Chapter 6 provides an overview of statement types and the tasks associated 
with statement types in Oracle’s Knowledge Management.

■ Chapter 7 provides an overview of categories and the tasks associated with 
categories in Oracle’s Knowledge Management.

■ Chapter 8 provides information about authoring flows in Oracle’s Knowledge 
Management and the tasks associated with authoring flows.

Typographic Conventions
This manual uses the typographic conventions listed in the following table:

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 

Convention Meaning

italic text Book titles

Courier text User commands, file content examples, directory names

UPPERCASE Structured Query Language (SQL) commands, initialization 
parameters, profile options, responsibilities, or environment 
variables

boldface text Menu, button, keyboard, and form options, emphasis

< > Angle brackets enclose user-supplied names. 

Note: Do not type the angle brackets.
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documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle Corporation does not own or control. Oracle Corporation neither 
evaluates nor makes any representations regarding the accessibility of these Web 
sites. 

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle’s Knowledge Management.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.

Related Documentation
Oracle’s Knowledge Management shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle’s Knowledge Management.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.



xii                                                                                        

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle’s Knowledge 
Management (and any other Oracle Applications products). This guide also 
includes information on setting user profiles, as well as running and reviewing 
reports and concurrent processes.

You can access this user’s guide online by choosing Getting Started with Oracle 
Applications from any Oracle Applications help file.

Documents Related to This Product

Oracle’s Knowledge Management Implementation Guide
This guide provides the implementation steps for implementing Oracle’s 
Knowledge Management. It also covers the mandatory and optional dependencies 
for setting up Knowledge Management, Verifying the implementation, Integration 
of Oracle’s Knowledge Management with Other Oracle Products, and Diagnostics 
and Troubleshooting.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.
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Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
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products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle’s Knowledge 
Management. This manual details additional steps and setup considerations for 
implementing Oracle’s Knowledge Management with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle’s Knowledge Management with 
Oracle Applications' Multiple Organization support feature, so you can define and 
support different organization structures when running a single installation of 
Oracle’s Knowledge Management.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle’s Knowledge Management implementation team, as well as for users 
responsible for the ongoing maintenance of Oracle Applications product data. This 
manual also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink
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Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle’s Knowledge 
Management and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University's online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle’s Knowledge 
Management working for you. This team includes your Technical Representative, 
Account Manager, and Oracle’s large staff of consultants and support specialists 
with expertise in your business area, managing an Oracle8i server, and your 
hardware and software environment.



xvi                                                                                        

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Top Tech Docs/ERP Applications/Applications Installation and Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Top Tech Docs/ERP Applications/Applications 
Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.
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About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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1
Introduction to Oracle’s Knowledge

Management

This chapter discusses the key features and process flows of Oracle’s Knowledge 
Management. Sections in this chapter include:

■ Section 1.1, "Overview"

■ Section 1.2, "Oracle’s Knowledge Management Key Features"

■ Section 1.3, "Oracle’s Knowledge Management Integrations"

■ Section 1.4, "What’s New"

■ Section 1.5, "What’s Obsolete"

1.1 Overview
Oracle’s Knowledge Management is an information management system that 
utilizes knowledge capture, storage, and distribution tools developed by Oracle. 
Implementing Oracle’s Knowledge Management provides the features of solution 
search, creation, organization, and immediate access to new solutions. Oracle’s 
Knowledge Management provides focused results that more directly relate to the 
issue being researched, thus reducing the cost of providing service while increasing 
customer satisfaction, and gaining an edge over competitors.

Oracle’s Knowledge Management currently provides solution management 
functionality to other Oracle applications like Oracle iSupport, Oracle Support, 
Oracle Field Service, Oracle Depot Repair, and Oracle eMail Center. The architecture 
has been designed to support diverse use, and is expected to be used by other 
Oracle products.
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1.2 Oracle’s Knowledge Management Key Features
Oracle’s Knowledge Management includes the following features:

Integration With Other Oracle Applications
Knowledge Management is integrated with other Oracle Applications like Oracle 
iSupport, Oracle Support, Oracle Field Service, Oracle Depot Repair, and Oracle 
eMail Center. Users of all these applications can search the same knowledge base for 
solutions and contribute new solutions to the knowledge base.

Multiple Search Methods 
You can select from multiple search methods available in Oracle’s Knowledge 
Management. 

The search methods include All Keywords, Any Keywords, Fuzzy Match, Theme, 
Accumulate, Intermedia, and Reference Number. A query can consist of a single or 
multiple search terms, the latter separated by spaces.

Oracle’s Knowledge Management uses InterMedia Text 8.1.7 for text searching.

Product, Platform, or Category Specific Search of Solutions
To focus search results, you can search for solutions under different products, 
platforms, and/or categories.

Product and platform fields on the Advanced Search user interface allows a user to 
focus the search and obtain results that contain the specific product and/or 
platform as well as solutions that are generic for all products and/or platforms. The 
product and platform information is entered either from Oracle Support’s service 
request form or a user can select from a list of values that are loaded from Oracle 
Inventory.

Category selection allows a user to select a category or a subcategory to focus the 
search to a specific information area more easily and quickly than adding additional 
query statements.

Finding Matching Statements/Solutions
While creating a statement, you can find matching statements or solutions in the 
knowledge base to prevent duplication.
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Finding Related Statements/Solutions
You can reuse statements in more than one solution. Finding related 
solutions/statements is the process of following the statement’s reused links to 
locate other related solutions/statements. 

Creating and Searching by Multiple Solution Types
Information in Oracle’s Knowledge Management is organized into solutions, that is 
a collection of statements. You can create multiple solution types to organize 
solutions. You can also search by either symptom/cause/action (default) solution 
type or any other solution type, such as problem/resolution, that you create.

Solution Authoring Features
Solution authoring functionality includes creating new solutions and updating 
existing solutions. Authors can also check solutions in and out of the knowledge 
base. For source control, only one internal user can edit a solution and/or statement 
at one time. An author can set up the access level for solutions and also create new 
solutions by reusing existing statements. The Knowledge Management system 
checks and prevents the creation of duplicate solutions or statements.

Categorization of Solutions 
In Oracle’s Knowledge Management, solutions are segregated in categories or 
folders for browsing or for performing a category specific search for solutions.

A merchant can categorize solutions for easy retrieval by its users. A user can select 
a category or a subcategory during search to focus the search to a specific 
information area. 

Adding Attachments, External Links, and/or Comments to Solutions 
This feature allows knowledge workers, Knowledge Management administrators, 
and customer service representatives (internal users) to add supporting and related 
information, links to other objects, or comments to a solution to enhance its 
usefulness. Comments are used by solution reviewers as a communication channel.

The functionality of attaching external links and attachments is now available from 
the Solution Detail screen only. 

User Defined Search Result Order 
You can select the way in which the search results for solutions will be displayed in 
the results list. A user can define the following display criteria:
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■ Relevancy based on percent match. For example, only display solutions that 
match the query 90% or better

■ Number of rows to be displayed per screen

You can also sort by Score, Type, Number, Title, Last Update Date in either 
ascending or descending order. 

Solution Scoring
Each solution is scored based on the text match performed by InterMedia Text. The 
maximum score is 100. Solution scores vary depending on the search method being 
used.

Integration with Oracle Workflow 
Oracle Workflow integration provides a workflow process in Oracle’s Knowledge 
Management. It is a flexible method for Oracle’s Knowledge Management users to 
define their own solution authoring flows with processing steps that are specific to 
their needs.

1.3 Oracle’s Knowledge Management Integrations
Oracle’s Knowledge Management integrates with the following Oracle 
Applications:

1.3.1 Oracle iSupport
Oracle iSupport is a customer service portal that allows both customer and 
employee users of a service organization to resolve their issues themselves and to 
receive assisted service over the Internet. It is designed to enhance customer 
satisfaction while cutting the costs of customer support and improving the 
productivity of service organizations.

Oracle iSupport uses Oracle’s Knowledge Management to search for published 
solutions. Oracle iSupport End users and service request agents can search 
Knowledge Management for solutions. Oracle iSupport end users can also see 
frequently used solutions and solutions recommended by an Knowledge 
Management administrator, without waiting for a service agent’s assistance.

1.3.2 Oracle Support
Oracle Support (part of the Oracle TeleService suite) is a Service Request 
Management System that integrates with Oracle’s Knowledge Management for 
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resolving customer issues. It is an agent facing application used by a customer 
service representative/agent (CSR). Oracle TeleService provides an integrated 
solution for conducting all aspects of customer management and interaction. It 
provides call center agents with the tools and information required for effective 
customer relationship management. See the latest version of Oracle Support User 
Guide for more information.

The integration of Oracle Support’s Service Request module with Oracle’s 
Knowledge Management reflects the following process flow:

■ A CSR receives a customer call. The agent opens a service request by entering 
customer information and verifying service eligibility. 

■ The CSR notes the customer problem. While writing the problem description, 
he searches the knowledge base for similar information. If the same or similar 
problem exists, a solution may be available as well. Agents can access more 
solutions than customers.

■ The CSR initiates a search in the knowledge base for an existing solution. If one 
is found, it is used. If not, he can create a new solution. 

1.3.3 Oracle Depot Repair                                                                                                                                                                                   
Oracle Depot Repair is designed to track and manage the repair process in a service 
organization. This application reduces customer downtime and helps bridge the 
gap while the product is being repaired. 

Oracle’s Knowledge Management allows a technician in Oracle Depot Repair to 
review the full problem solution life span, starting from the initial diagnosis of a 
problem to problem resolution. See the latest version of Oracle Depot Repair User 
Guide for more information.

1.3.4 Oracle eMail Center
Oracle eMail Center is used for managing inbound email interactions with 
customers, partners, suppliers, employees, and others that interact with an 
organization. Oracle eMail Center provides agents with tools and capabilities to 
maximize their productivity and effectiveness. See the latest version of Oracle eMail 
Center User Guide for more information. 

Oracle’s Knowledge Management integrates with Oracle eMail Center during 
inbound email processing. Oracle’s Knowledge Management can be searched for 
appropriate solutions by Oracle eMail Center agents while responding to an email. 
The searched solutions can be sent as an e-mail message to the customer. 
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1.3.5 Oracle Quality Online
Oracle Quality Online (OQO) is a comprehensive web-based application that can be 
used by organizations to track and manage product defects and enhancements. The 
resolved defects in Oracle Quality Online can be submitted to Oracle’s Knowledge 
Management as solutions. This increases the knowledge base of solutions and 
allows users of both modules to search for existing solutions and to prevent 
duplicate defect entry. 

See the latest version of Oracle Quality Online User Guide for more information.

1.4 What’s New
The following new features have been added to Oracle’s Knowledge Management 
in this release.

■ Search and Browse Integration

■ Advanced Search to Create Solution Integration

■ Obsoleting Statements

■ Dynamic Information Linking

■ Mandatory Statement Types in Solution Authoring

■ Solution “Get Lock” by Knowledge Management System Administrators

■ Improved Search For Solutions In Progress Screen

■ Statement Content Type

■ Enhancements to Comments

■ Statement Ordering

■ Solution and Statement Import/Export Functionality

■ External Links and Attachments at the Solution Level

Search and Browse Integration
Search and browse functionality has been integrated on the Basic Search screen. You 
can browse through various categories that have been setup and search for 
solutions interchangeably. During search, search results replace the browsing 
section. You can also view solutions within the last “N” Days for a selected 
category. The solutions appear at the bottom of the screen in a table. The values for 



What’s New

                                                                   Introduction to Oracle’s Knowledge Management 1-7

the View drop-down list are taken from the values defined in the Frequently Used 
Definition screen.

Advanced Search to Create Solution Integration
A tighter integration between the Advanced Search screen and the Solution Detail 
screen has been implemented to enable the search parameters to be passed back and 
forth.

Obsoleting Statements
The procedure to obsolete statements has been implemented in this release of 
Knowledge Management. Obsoleting a statement prevents it from appearing in the 
result list during the statement search process. Statements need to be obsoleted if 
they are deleted from a solution in the review process and are not linked to any 
other solutions.

In previous versions of Knowledge Management, when a solution was obsoleted, 
there was no way to obsolete the associated statements. These statements remained 
active in the knowledge base without being linked to a solution. This affected the 
statement reuse process. The statements that had no links to any other solutions 
were also displayed during statement search. It also affected the solution creation 
process. 

Dynamic Information Linking
Dynamic information linking is the functionality that allows a solution author to 
select keywords or phrases within a solution and link them to external information. 
A user can select the word or phrase to display the information that the word or 
phrase in the solution is linked to. For example, a word or phrase may be linked to 
other bugs, other solutions, white papers, presentations, etc.

Dynamic linking functionality created in Oracle Quality Online is used in 
Knowledge Management. To set dynamic links,  see Setting Up Note Token Rules.

Mandatory Statement Types in Solution Authoring
A method to identify and add mandatory statement types in a solution type while 
creating a solution has been implemented. For this release of Knowledge 
Management, an asterix (*) is added to the left of each mandatory statement type in 
the statement type drop down list on the Statement Detail screen. The mandatory 
statements types to be included in a solution are determined by the Knowledge 
Management system from the solution type that you select. If all mandatory 
statement types are not included in a solution, then you can only save a solution 
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that you can work on and complete later, but you cannot save and submit a solution 
to an authoring flow.

Solution “Get Lock” by Knowledge Management System Administrators
Knowledge Management system administrators can get a lock for a solution, if the 
person who has locked the solution is no longer available to unlock it and complete 
the steps in an authoring flow. A Get Lock button and a Get Lock Confirmation 
screen have been added to the Solution Detail screen. A Get Lock button and the 
Get Lock Confirmation screen are only visible to a user who has Knowledge 
Management System Administrator responsibility.

In the previous release, solution locking was implemented to prevent other internal 
users from editing a solution that was being worked on by a user.

Improved Search For Solutions In Progress Screen 
A new drop down box titled Filter By has been added in this release in the Search 
For Solutions In Progress screen. The three options are: 

1. Solutions I’m Currently Working On (Default): This list has all solutions that the 
user has created and saved but not submitted to an authoring flow and 
solutions that have been checked out by him.

2. Solutions In Progress I can Check Out For Editing: This list has all solutions that 
a user can check out.

3. All Solutions In Progress: This is a list of all the solutions in progress including 
the solutions that the user cannot check out.

Statement Content Type
A procedure to display the statement detail in a solution in the same format as a 
solution author specifies, has been implemented. You can select the statement 
content from the Content Type drop-down list on the Statement Detail screen. The 
options are:

■ Text: the content in the statement is rendered as text only. HTML tags are 
not rendered as HTML but as text.

■ HTML: the content in the statement is rendered as HTML.

■ HTML with Autolinks: is extensible HTML. The content in a statement is 
rendered as HTML and dynamic links are also displayed.

■ Text with Autolinks: the content in a statement is rendered as text and 
dynamic links are also displayed.
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Enhancements to Comments
The following enhancements to improve comment processing have been 
implemented:

■ The method of attaching comments has been changed, so that comments are not 
removed when a new solution version is created. The new comment processing 
has the following flow:

■ Comments are attached to a solution through all its versions, leading to a 
new published solution.

■ Any new comments added to an already published solution are added to 
the work-in-progress (WIP) copy of the solution.

■ When the WIP copy of the solution is published, the original solution and 
the comments attached to it are obsoleted.

■ To access the previous versions of a solution, you can write and use a SQL 
report.

Statement Ordering
This feature controls the order in which statements are displayed in a solution. The 
Knowledge: Statement Display Order on Solution Detail Page profile option (at the site 
level) is used to specify an order.

Solution and Statement Import/Export Functionality
The functionality to import and export solution and/or statements into or from 
Knowledge Management has been implemented. 

■ Import/Export Statement: To Import and export statements, Import and Export 
buttons have been added on the Statement Detail screen. You can select the 
Import button to navigate and choose the source file (only text files) for the 
statement to be imported. Similarly, you can select the Export button to export 
or download and save the statement being viewed. You can import or export 
one statement at a time in Knowledge Management.

■ Import/Export Solution: Concurrent programs are used to import and export 
solutions in Knowledge Management. Knowledge Management Solution 

Note: the statement summary field can only include text. The 
content type selection applies only to the statement detail field.
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Export Program is used to export solutions from Knowledge Management and 
Knowledge Management Solution Import Program is used to import new 
solutions and to update existing solutions in Knowledge Management. 

External Links and Attachments at the Solution Level
The functionality of attaching external links and attachments is now available from 
the Solution Detail screen only. 

1.5 What’s Obsolete
The following features/functionality have been obsoleted in this release of Oracle’s 
Knowledge Management:

■ Forms version of Knowledge Management has been obsoleted.

■ MES tab is no longer visible from the Knowledge Management user interface.

■ View History on the Solution Detail screen has been obsoleted.

■ You cannot view External links from the Statement Detail screen.

■ You cannot add an attachment to a statement.

■ The Relationship drop-down list on the Statement Search screen has been 
removed.
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2
Overview of Using Oracle’s Knowledge

Management

This chapter provides an overview of accessing Oracle’s Knowledge Management 
and a list of tasks that can be done in Oracle’s Knowledge Management. Sections in 
this chapter include:

■ Section 2.1, "Accessing Oracle’s Knowledge Management"

■ Section 2.2, "Summary of Oracle’s Knowledge Management Tasks"

2.1 Accessing Oracle’s Knowledge Management 
Oracle’s Knowledge Management has both internal users and external users that 
can search for published solutions. Knowledge Management is used by several 
Oracle applications for searching and creating solutions. For example, Oracle 
iSupport end users can access Knowledge Management from the Support tab on the 
Oracle iSupport Homepage to search for published solutions. 

Knowledge workers, customer service representatives, and Knowledge 
Management administrators can access Knowledge Management user interface 
directly to search for solutions and to create new solutions. Internal users have 
various levels of setup and other administrative permissions.

Roles determine screen-level permissions. A user can have one or more roles. 
Responsibilities determine the menus that a user views. Every user has to have at 
least one responsibility.

■ External users are end users who have only view and search access to published 
solutions. 

■ Internal users include customer service representatives/agents, knowledge 
workers, and Knowledge Management administrators. 
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The following table lists responsibilities, menus, and tabs associated with internal 
Knowledge Management users.

Prerequisites
None

Login
Use your HTML login, jtflogin.jsp, to log in to the Self Service Administration 
(Oracle iSupport Homepage).

Responsibility
None

Steps

For External User (Oracle iSupport Users)
Select the Support tab on Oracle iSupport Homepage. (For more information, see 
Oracle iSupport Documentation)

For Internal Users
Navigate to Authoring.

Table 2–1 Responsibilities, Menus, and Tabs for Internal Knowledge Management 
Users

Responsibilities Menus Tabs

CS_KB_KNOWLEDGE_
WORKER

CS_KB_TOP_KW_MENU Solutions >Search, 
Authoring

CS_KB_AGENT CS_KB_TOP_AG_MENU Solutions >Search, 
Authoring

CS_KB_SYS_ADMIN CS_KB_TOP_MENU Solutions> Search, 
Authoring, Setup
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2.2 Summary of Oracle’s Knowledge Management Tasks
Use Oracle’s Knowledge Management to perform the following types of tasks: 

■ Managing Search

■ Managing Solutions

■ Managing Solution Types

■ Managing Statement Types

■ Managing Solution Categories

■ Managing Authoring Flows
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3
Managing Search

This chapter includes information about the search functionality in Oracle’s 
Knowledge Management. Sections in this chapter include:

Section 3.1, "Overview of Managing Search"

Section 3.2, "Basic Search"

Section 3.3, "Advanced Search"

Section 3.4, "Searching for a Statement"

Section 3.5, "Searching Solutions in Progress"

3.1 Overview of Managing Search
Knowledge Management integrates with Oracle InterMedia Text to provide 
complete and flexible search functionality. 

All Knowledge Management users can search for published solutions using the 
following search methods: 

■ Basic Search allows you to search for a solution based on a keyword and/or by 
navigating through a category tree. 

■ Advanced Search is more comprehensive. You can search for solutions under 
different categories, products, and/or platforms. By using Advanced Search, 
you can do the following kinds of searches:

Finding Matching Statements
This is a text based search performed on statements. It compares the keywords that 
you enter in the search field to the summary of the statements in the repository. 
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Scores are calculated by the Intermedia Text engine and depend on the search 
option that you choose.

Finding Related Statements
The related statement search is done in two stages. First, a matching statement 
search is done on one or more keywords that you want to search for. Then, the 
statements are selected from the search results section, added to the criteria section, 
and a related search is done. A related statement search tries to find other 
statements that have been used in a solution containing the selected statement. 

Finding Matching Solutions
This is a text based search. The selected statement summary is compiled into 
keywords. The search is performed on solutions comparing the keywords to the 
solution content, which includes the solution title, the summary, and descriptions of 
all the statements contained in the solution. Scores are determined by the 
Intermedia text engine.

Finding Solutions Related to Statements
This search is based on the links that the selected statements have to solutions. Any 
solution that has a relationship with any of the selected statements will appear in 
the search results. Relationships are created between a statement and a solution 
when a statement is used in the solution. The score reflects the number of selected 
statements that are contained in each solution search result. Solutions having most 
of the selected statements will have higher scores.

3.1.1 Multiple Text Search Options
The following text search options are available in both Basic and Advanced Search 
screens:

■ All Keywords: This search uses the AND operator. The search results must 
match all terms in the query. For example, if you enter Oracle server as a search 
query, Oracle’s Knowledge Management would read it as Oracle AND server 
and send it to Intermedia. 

■ Any Keywords: This search uses the OR operator. This search can match one or 
more query terms. 

■ Fuzzy Match: In this search, the query keywords are expanded into a set of 
similarly spelled keywords, before a search is performed. This search is helpful 
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if there are frequent misspellings of the query keyword in the repository. The 
search will find incorrect spellings and synonym matches to the query terms.

■ Theme: This is also called an about search in Intermedia. Intermedia categorizes 
the documents in its repository into themes, based on their textual content. 
When this search is performed, the query keywords are compared with the 
theme index. Documents having the same themes as the keywords appear in 
the result list. For example, if the query term is soccer, a document about the 
World Cup could be among the results. This search will determine the theme of 
the query and locate any references to that theme.

■ Accumulate: This search will find documents that contain at least one of the 
query terms. The results are scored based on two criteria: 

■ Document term scores: Each query keyword that appears in the result is 
given a score of 1 and the query keywords that don’t appear in the result 
are given a score of 0.

■ Document term weights: Refers to the total weight that you place on each 
query term. For example, a query such as x, y, z may have term weights of 1 
for each term. A query such as x, 3*y, z may have term weights of 1, 3, and 1 
for each term in that order. The highest score is assigned to documents that 
have the highest total term weight.

■ Intermedia: In this search you can enter your own Intermedia operators like 
OR, AND, PHRASE, +, -, etc. If you do not enter an operator, this search 
performs a phrase search. It was previously known as Intermedia Syntax 
search.

■ Reference Number: Every solution in Oracle’s Knowledge Management is 
assigned a unique number. This search will find the solution that is associated 
with the number entered in the search query field. 

3.1.2 Understanding Search Result Order
The search results for solutions or statements appear in the Results: Search section 
on the Advanced Search screen. The table columns are:

■ Score: shows how closely the results match the query

■ Type: indicates the solution or statement type

■ Number: indicates the solution or statement number. It is alphanumeric

■ Last Updated: shows the last date on which the solution or statement was 
updated
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■ Summary: indicates the solution or statement title or solution/statement 
summary

3.1.3 Solution and Statement Distribution Options
In Knowledge Management, a distribution level attribute is used for solutions and 
an access level attribute for users to control the access of solutions to different users. 
Access levels are assigned based on the user’s assigned permissions.

While creating a solution, an author assigns the solution a distribution level. The 
options are internal, external, limited, and restricted.

■ Internal Distribution: a solution can be viewed and/or distributed only within 
the company.

■ External Distribution: (lowest security) a solution can be distributed both to 
internal users within a company and to external customers.

■ Limited Distribution: a solution can be viewed within a company but may be 
distributed outside a company under specific conditions about its use.

■ Restricted Distribution: (highest security) a solution can be viewed and/or 
distributed only among selected groups of internal users within a company.

3.2 Basic Search
Perform a basic search if you want to find a solution using a simple keyword or to 
navigate through a category. Use this procedure to search for a published solution 
in Oracle’s Knowledge Management.

Login
Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Prerequisites
None

Steps
1. Navigate to Search > Basic Search.



Advanced Search

                                                                    Managing Search 3-5

2. Select a search option. The available options are: All Keywords, Accumulate, 
Any Keywords, Fuzzy Match, Theme, Intermedia, and Reference Number. (For 
more information on search options, see Multiple Text Search Options).

3. In the Search For field, enter known information to narrow down your search.

4. Optionally, you can navigate through a category tree.

5. Select Go. The results appear in the Solutions section. 

3.3 Advanced Search
Advanced search allows you to search for solutions in specific categories, products, 
platforms or any combination of these. You can also select a solution type to narrow 
the search results and to choose the type of solutions that you want to find or you 
can search all solution types to get the maximum number of results. Searching by a 
statement type allows you to find an identical or similar statement to be used in 
finding all solutions that has a relationship to that statement. You can enter multiple 
queries, which can be used one at a time, or in combination, to obtain the best 
search results.

The search result list displays a percent score and a color bar to indicate the 
closeness of the text match to the original query. The score is determined by 
InterMedia Text and varies based on the search option selected. Since the entire 
solution is indexed and InterMedia Text performs an analysis against all terms 
found in the solution, the title may or may not closely match the query that is 
entered. In addition, a description pertaining to the statement or solution, and a last 
updated date is provided to indicate how current the information is.

Login
Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Prerequisites
None

Steps 
1. Navigate to Search > Basic Search. Select the Advanced Search link. Advanced 

Search screen appears.

2. In the Filter Search section, you can optionally select categories, products, 
and/or platforms to narrow down the search criteria.
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3. Select a search option. The available options are: All Keywords, Accumulate, 
Any Keywords, Fuzzy Match, Theme, and Intermedia. (For more information 
on search options, see Multiple Text Search Options).

4. Select a score to narrow the search results.

5. In Describe Your Problem section, select a solution type.

6. Select a statement type and enter any keywords to be searched in the Summary 
field.

7. Click Find Statements to search for statements or click Search to search for 
solutions. The results appear in the Results: Search section.

8. If you selected Find Statements, the statements searched appear in the Results: 
Search section. Select a statement and select one of the following options:

■ Replace all statements in problem description

■ Replace only selected statements in problem description

■ Append to problem description

9. Optionally, you can navigate to the Solution Detail screen by selecting the 
Create Solution button.

3.4 Searching for a Statement
Use the Search Statements screen to search for statements in the knowledge base.

Login
Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
■ CS_KB_KNOWLEDGE_WORKER

■ CS_KB_SYS_ADMIN

Prerequisites
None

Steps
1. Navigate to Search > Statement Search. The Search Statements screen appears.
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2. In the Search Statements screen, enter some known information to narrow your 
search:

■ Statement Number: is the number assigned to a statement in Oracle’s 
Knowledge Management when a statement is created.

■ Statement Type: is the category assigned to a statement when a statement is 
created.

■ Summary: a word or a sentence used in the summary of the statement.

■ Sorted By: the options are, Last Updated Date, Statement Number, or Score. 

3. Select Go. The Search Statements Results screen appears with the results.

3.5 Searching Solutions in Progress
Solutions appearing in the Work Pending screen are solutions that have either been 
created and saved by an author but not submitted to an authoring flow for approval 
or have been checked out by a user but have not been submitted back to an 
authoring flow. Solutions that have been rejected to an author will also appear in 
the Work Pending screen.

Solutions in Search For Solutions In Progress screen are solutions that have been 
submitted to an authoring flow. These solutions have not yet been published. Once 
a solution has been submitted to an authoring flow, it is no longer in the author's 
work pending queue. 

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
■ CS_KB_KNOWLEDGE_WORKER

■ CS_KB_AGENT

■ CS_KB_SYS_ADMIN

Prerequisites
None
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Steps
1. Navigate to Authoring >Work Pending. The Work Pending screen with all the 

solutions that you are working on appear. These are solutions that have been 
saved but not submitted to an authoring flow.

2. Select Search Work in Progress button. Search For Solutions in Progress screen 
opens.

3. Enter one or more search criteria to narrow down the search results.

4. Select Search. Search results appear in the Search Results sub-section.

5. Select the numbered link to view details about the selected solution. Solution 
Detail screen appears. If you have CS_KB_SYS_ADMIN permissions, and the 
solution has been locked by another user, then you can view the Get Lock 
Button. 

6. Select the Get Lock button to navigate to Get Lock Confirmation screen. Select 
OK. Solution Detail screen appears. As an administrator you can update a 
solution that had been locked by another user.
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4
Managing Solutions

This chapter includes an overview of solutions and the tasks associated with 
solutions in Knowledge Management. The sections in this chapter include:

■ Section 4.1, "Overview of Solutions"

■ Section 4.2, "Creating a Solution"

■ Section 4.3, "Viewing Solutions in Progress"

■ Section 4.4, "Setting Up Recommended Solutions"

■ Section 4.5, "Setting Up Frequently Used Definitions for Solutions"

4.1 Overview of Solutions
In Oracle’s Knowledge Management, information is organized into solutions that 
are organized into solution types.

A solution is a collection of statements. The basic element in the knowledge base is 
a statement. A statement consists of a summary field (maximum 500 KB) and a 
detail field (maximum 4 GB), both of which are fully indexed for quick searches.

One or more statements comprise a solution or a complete item of information. 
These statements can either be unique to a solution or can be shared with other 
solutions.

Each solution is comprised of one or more mandatory statements and some optional 
statements.

A solution contains a title, and links to statements, attachments, external links, and 
comments. The merchant sets solution viewing limitations. A solution can be 
categorized into categories, products, and platforms.
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Understanding Solution Usage Count
In Oracle’s Knowledge Management the solution usage count is updated 
depending on the number of times a solution is used to solve a problem. Every time 
a solution is used to solve a problem, the usage count is increased by one. In the 
applications that integrate with Oracle’s Knowledge Management, for example, 
Oracle iSupport, the question, Can this solution solve your problem, appears in the UI 
flow. If a user selects yes, then the Knowledge Management Update Solution Used 
Count concurrent program updates the used counts in Oracle’s Knowledge 
Management based on a time schedule setup by an administrator. For example, if 
the schedule is every eight hours, then, the usage count will also be updated every 
eight hours.

Status of Solutions and Statements
Solutions and statements have a status attribute that describes the phase of review 
that the solution or statement has gone through. Common solution statuses are: 
Draft, Under Edit, Technical Review, Editorial Review, Obsolete, and Published. A 
statement can either be in the draft status or published status.

The status of a solution is used in the authoring flow process. Each status is 
associated with a step in an authoring flow and only users that are members of a 
user group that is assigned to that authoring flow and that step can modify the 
solution. When a user reviews a solution, he can select the next step in the flow, 
bypass several steps if he is a member of multiple steps resource group, or reject the 
solution back to any of the previous steps.

Understanding Attachments
Attachments are links from a solution to a supporting item of information that 
enhances the value of the solution for its users. Attachments can include graphics, 
scripts, and file formats such as PDF and EXE.

Attachments are added in the Solution Detail screen. To add an attachment, a search 
process is provided to locate the attachment on a user’s computer. A title is added 
and an access path for navigating to the attachment is provided. To view an 
attachment, you need to have the appropriate software. For example, you need 
Adobe Reader for viewing attachments in the PDF format.

Integration with Oracle Workflow
Oracle’s Knowledge Management integrates with Oracle Workflow to provide an 
authoring flow process before a solution is published. After a solution is created, it 
is assigned to a user (resource) group for further action, e.g, editorial review, 
technical review, etc. before being published to external users.
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Setting Up Solution Authoring Profile
Authoring flows define the steps that a solution goes through in the solution 
authoring flow process. After creating a solution and submitting it to an authoring 
flow, a Knowledge Management administrator, knowledge worker, or a customer 
service representative, in the assigned user group associated to the step that the 
solution is in, can approve or reject a solution to the next or previous step of the 
authoring flow. 

Members of a user group can set up their own profile, i.e, select one or more 
products and/or categories in the Solution Authoring Profile screen to receive a 
notification that a solution related to that product and/or category is ready for 
review. Members who do not subscribe to any product or category will not receive a 
notification but can search for all work-in-progress solutions from the Work 
Pending screen by selecting Search Work in Progress button. Refer to the Oracle 
Workflow Guide on how to set up and monitor a workflow.

Prerequisites
None

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Select Profile > Solution Authoring Profile.

4. In the Categories sub-section, select Add. The Select Solution Categories screen 
appears.

Note: E-mail notifications will be sent only if the Workflow mailer 
is setup and properly configured. The PHP/Self Service Workflow 
notifications screen can also be used to view notifications. Please 
see the Workflow documentation for more information on how to 
start and configure the workflow mailer.

Note: Your system administrator can give you the values that 
should replace <host> and <apache port> in this URL.
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5. Check the check-box corresponding to the solution category that you want to 
select. Select OK.

6. In the Products sub-section, select Add. Select a product from the list or search 
for the product.

7. Select Update. The Solution Authoring Profile is updated.

4.2 Creating a Solution
In Knowledge Management, a distribution level attribute is used for solutions and 
an access level attribute for users to control the access of solutions by different 
users.

There are four seeded distribution levels:

■ Restricted (highest security) 

■ Internal

■ Limited 

■ External (lowest security)

When solutions are created, they are assigned a distribution level by the author. 
Users are assigned an access level that is based on their permissions. Users need 
appropriate access levels to view solutions in different distribution levels.

Login
Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
■ CS_KB_KNOWLEDGE_WORKER

■ CS_KB_AGENT

■ CS_KB_SYS_ADMIN

Prerequisites
Internal Knowledge Management users with create permissions (CS_Solution_
Create) can create a solution.
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Steps
1. Navigate to Authoring > Create Solution. The Solution Detail screen opens.

2. Enter a solution title. The maximum length of a solution title can be 80 
characters.

3. Make a selection for the Distribution field. The options are Internal, Limited, 
Restricted, or External. You can view one or more of these values depending on 
your access level.

4. You can optionally select one or more categories, products, and/or platforms to 
be associated with this solution. To add a category, product, or platform, select 
Update. The corresponding screen appears. Make the required selection.

5. Select a Solution Type from the drop-down list.

6. Select the Add button to navigate to the Statement Detail screen or select Search 
to navigate to the Advanced Search screen.

a. On the Statement Detail screen, select a Statement Type. 

b. Select a Content Type. The options are: Text, Text with Autolinks, HTML, 
and HTML with autolinks. The content type is only for the statement detail 
field.

c. Select a Distribution option. The options are External, Internal, Restricted, 
and Limited. One or more of these values appear depending on your access 
level.

d. Enter a summary for the statement. (Maximum limit is 500 byte).

e. Enter information about the statement in the Detail field. (Maximum limit is 
4 GB). 

f. Optionally, you can also import or export a statement from or to a local text 
file by selecting the Import or Export button. 

Note: You can also remove a related category, product, or 
platform from a solution.

Note: To save and submit a solution to an authoring flow, you 
have to create and save the mandatory statement types. Without 
including the mandatory statement types, you can only save a 
solution and not submit it to an authoring flow.
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g. Select Save.

7. Optionally, you can also add external links (KB Defects, Product, Task Template 
Groups, Service Request, Depot Repair) or attachments to the solution by 
choosing an option on the Add Another drop-down list. Select Add. A 
corresponding screen appears. Make your selection

 

8. Either select Save Changes or Save and Submit to Authoring Flow radio button. 
You can only save a solution that has statements of compatible statement types 
for the selected solution type.

9. If you select Save Changes, then the Solution Detail screen appears with the 
solution details. The solution will have a saved status and will appear in the 
Work Pending screen. You can update this solution. You can also view, 
and/or add comments attached to this solution by selecting the Comments 
button. (See Adding Comments to a Solution). 

10. If you select Save& Submit to Authoring Flow radio button, and you have setup 
authoring flows, then the Available Authoring Flows screen appears. Choose an 
authoring flow and select OK. 

11.  Another screen appears that prompts you to select a status. Select a status. 
Select OK. The summary of the solution submitted to the authoring flow 
appears. Select OK. The Work Pending screen appears from where internal 
users with necessary permissions can search for a work- in-progress solution by 
selecting the Search Work in Progress button.

12. The Oracle Workflow engine determines the user group that is associated with a 
particular status of the solution. An E-mail or notification about the solution 
being ready for a review is sent to all members of that user group who have 
subscribed to a product or a category in the Solution Authoring Profile screen. 
The solution has to be related to the subscribed category/product. Any member 

Note: You can obsolete a published statement from a solution, by 
checking the select button corresponding to the statement that you 
want to obsolete and then select Delete. The statement that is not 
linked to any solution is obsoleted from the knowledge base when 
the solution is published or obsoleted. A draft statement can be 
obsoleted when the solution is saved.
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can select the link in the E-mail and reply to the E-mail to accept the solution. 
(See Approving a Solution).

4.2.1 Adding Comments to a Solution
You can add comments to a solution from the Solution Detail screen. Comments are 
used to provide feedback for correcting a solution or for enhancing the solution 
value. All added comments have a draft status and an internal distribution option. 
Comments attached to a solution can only be viewed by internal Knowledge 
Management users.

Login
Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
■ CS_KB_KNOWLEDGE_WORKER

■ CS_KB_AGENT

■ CS_KB_SYS_ADMIN

Prerequisites
Internal Knowledge Management users with permissions to add comments (CS_
Solution_Comments_Add) can add and view comments to a solution.

Steps
1. Navigate to Authoring >Work Pending. The Work Pending screen with all the 

solutions in progress appears.

2. Select the numbered link of the appropriate solution to navigate to the Solution 
Detail screen to view details about the selected solution in progress. 

3. Select the Comments button. The Comments on Solution screen appears.

4. Select Add Comment. The Create Comment screen appears with the Solution 
Number, Author, Distribution, and Creation Date.

Note: To edit a solution, you must belong to the solution’s user 
group. The solution must be unlocked, and you must have 
appropriate status specific permissions. 
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5. Enter the comment summary.

6. Enter the comment detail.

7. Select Save. The Comments on Solution screen opens.

8. Select Return to navigate to the Solution Detail screen or select Add Comment 
to add another comment to this solution.

4.2.2 Approving a Solution
After creating a solution and submitting it to an authoring flow, a Knowledge 
Management internal user in the assigned user group at each step can either 
approve the solution to the next step with or without modifications, or reject the 
solution to any of the previous steps of the flow. Members of a user group assigned 
to the next step or previous step will receive a notification that a solution is ready 
for review.

When a solution in an authoring flow is submitted to the step that has the publish 
action, then the solution is published.

Login
Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
■ CS_KB_KNOWLEDGE_WORKER

■ CS_KB_AGENT

■ CS_KB_SYS_ADMIN

Prerequisites
To publish, or reject a solution to the next step or any previous step in an authoring 
flow, you have to be a member of the solution’s user group to whom that step is 
assigned.

You must have status specific permissions i.e, permissions to edit a solution in the 
draft status, solutions in technical review status, etc.

Steps
1. Navigate to Authoring >Search Work in Progress. The Work Pending screen 

with all the solutions that a user is working on appear. You can either choose 
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a solution or select Search Work in Progress button. The Search For Solutions 
In Progress screen appears. Search for the solution that you have to work on. 
Search Results appear.

2. Select the solution and select the numbered link to navigate to the Solution 
Detail screen for that solution.

3. Select Check Out and modify the solution. The Lock Confirmation screen 
appears. Select OK.

4. The Solution Detail screen appears. Make the required edits.

5. Select Save and Submit. A screen prompting you to select the next step appears. 
The options are: 

■ Continue the current process

■ Reject the solution

■ Switch to another process

6. If you select Continue the current process or Reject the solution, a screen for you 
to select a status appears. If you select Switch to another process, the Available 
Work Processes screen appears. Select another work process and select OK.

7. Depending on your previous selection, select the solution status. Select OK. A 
message that the solution has been submitted appears. When the solution is 
submitted to a step whose action is publish, then the solution is published.

4.3 Viewing Solutions in Progress
Solutions in progress are solutions that are still being worked on.

Login
Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
■ CS_KB_KNOWLEDGE_WORKER

Note: You can also select Comments to view any comments 
attached to the solution.
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■ CS_KB_AGENT

■ CS_KB_SYS_ADMIN

Prerequisites
View permissions (CS_Solution_View_Internal).

Steps
1. Navigate to Authoring >Work Pending.  To see solutions in progress that are 

not yet published the Search Work in Progress button must be used.

2. Select the numbered link to navigate to the Solution Detail screen to view 
details about that solution.

3. Select Search Work In Progress button to navigate to Search For Solutions In 
Progress screen to search for any in progress solution

4.4 Setting Up Recommended Solutions
Use this procedure to add or delete solutions from the recommended solutions list 
and select the sort order in which the recommended solutions will appear.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
■ CS_KB_KNOWLEDGE_WORKER

■ CS_KB_SYS_ADMIN

Prerequisites
Knowledge Management administrators and Knowledge Management workers 
with view permissions (CS_Rec_Sol_View) can view recommended solutions. 

Knowledge Management administrators with update permissions (CS_Rec_Sol_
Update) can update recommended solutions.

Steps
1. Navigate to Authoring > Top Solutions. The Recommended Solutions screen 

appears.
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2. To add a solution to the list, select Add. The Add Recommended Solution 
screen appears. Enter the Solution Number. Select Done.

3. To rearrange a solution, check the check-box next to the solution to be moved 
and select Move Up or Move Down.

4. To delete a solution from the list, check the check-box next to the solution to be 
deleted and select Delete.

4.5 Setting Up Frequently Used Definitions for Solutions
You can provide your customers with a list of frequently used solutions for a 
specific time period. Use this procedure to create definitions for standard lengths of 
time.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
Knowledge Management administrators with update permissions (CS_Freq_Used_
Def_Update) can add or update frequently used definitions.

Steps
1. Navigate to Setup > Frequently Used Definition. The Frequently Used 

Definitions screen appears.

2. Select the time period that you want to use as a default time period.

3. Select Update.

4. To add a new time period, select Add. The Add Definition screen appears.

5. Enter the new name, description, and number of days.

6. Select Save.

Note: You can also remove a time period from the list.
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4.6 Setting Up Note Token Rules
Setting Note Token Rules allows you to define parsing rules and destinations for  
hyperlinking keywords in the Note Details display.

To set Note Token Rules:

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
None.

Steps
1. Log in to the JTF login page as DEMS Administrator. Navigate to Standards 

> Token Rules.

2. Click Create Note Token Rule.

3. Enter a unique Name in the Name text field.

4. Enter a description in the Description text field.

5. In the Token section, enter the  keyword to hyperlink in the Value field. (a 
name for the linked text, e.g. http://, etc.)

6. Set Preceding and Following Delimiting Characters. The Preceding 
Delimiting Characters distinguish your token value from identical text 
values, and the Following Delimiting Characters determine where the 
hyperlink stops. Any combination of Following Characters are allowed 
between Token Value and Parameter, if any.

7. In the Parameter section, use the Type drop-down box to select a Parameter 
type Alphanumeric, Numeric or No Parameter.

8. Enter the Following Delimiting Characters for the parameter, if desired, 
and/or check the appropriate delimiting checkboxes. If No Parameter is 
selected, then the Following Characters, Minimum Length, and Maximum 
Length options are not allowed

9. Enter your minimum and maximum length parameters
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10. In the Destination section, select a Type using the drop-down box. If your 
type is Function, select a User Function Name using the LOV.  If your type is 
URL, enter the base url in the Base URL text field.

11. Click Create.
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5
Managing Solution Types

This chapter includes information about solution types and the tasks associated 
with solution types in Knowledge Management. The sections include:

■ Section 5.1, "Overview of Managing Solution Types"

■ Section 5.2, "Creating a New Solution Type"

■ Section 5.3, "Viewing a Solution Type"

■ Section 5.4, "Updating a Solution Type"

■ Section 5.5, "Deleting a Solution Type"

5.1 Overview of Managing Solution Types
A solution type can provide segmentation to the knowledge base, depending on 
how the information is captured and used. Organizing solutions in solution types 
makes searching for solutions more precise and the results more effective.

A system administrator can define the mandatory and optional statements for a 
solution type. For example, Oracle’s Knowledge Management is seeded with the 
symptom/cause/action (SCA) solution type. A system administrator can also create 
an unlimited number of solution types for their company’s specific needs.

A solution type should have a self-descriptive name and should follow the 
merchant’s naming conventions. Examples of common solution types are: 

■ SCA (Symptom/Cause/Action) 

■ PR (Problem/Resolution) 

■ QA (Question/Answer)
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5.2 Creating a New Solution Type
Oracle’s Knowledge Management is seeded with the solution/cause/action (SCA) 
solution type. Perform the following procedure to create a new solution type. 
Knowledge Management system prevents the creation of duplicate solution types.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
Knowledge Management administrators with edit permissions (CS_Type_Edit) can 
create a new solution type.

Steps
1. Navigate to Setup > Create Type. The Create Type screen appears.

2. From the Type drop-down list, select Solution.

3. Enter a name for the solution type in the Name field.

4. In the Description field, briefly describe the solution type. The description of a 
solution type is only for administrators and cannot be viewed by a customer.

5. Select Create. The Solution Type screen reappears with a Related section. 
Optionally, you can associate statement types or external links to the solution 
type.

5.2.1 Associating a Statement Type to a Solution Type
You can associate a statement type to a solution type in the Associate Statement 
Types screen.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN
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Prerequisites
None

Steps
1. Navigate to Setup > Solution Types. The Solution Type screen with a list of 

existing Solution Types appears.

2. Select the Solution Type Number link. The Solution Type screen for the Solution 
Type Number appears.

3. Select Add/Delete. The Associate Statement Types screen appears.

4. To add a statement type to the existing solution, choose the desired statement 
type from the Available Statements Types box and assign (>) it to the Selected 
Statement Types box. You can sort the selected statement types by using the up 
and down sort arrows.

5. Select Save to save the changes or select Cancel to restore the original values 
and return to the previous screen.

5.2.2 Disassociating a Statement Type from a Solution Type
You can disassociate a statement type from a solution type in the Associate 
Statement Types screen.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Steps
1. Navigate to Setup > Solution Types. The Solution Type screen with a list of 

existing Solution Types appears.

2. Select the Solution Type Number link. The Solution Type screen for the Solution 
Type Number appears.

3. Select Add/Delete. The Associate Statement Types screen appears.

4. To delete a statement type from the existing solution, choose the desired 
statement type from the Selected Statement Types box and use the arrow key 
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(<) to move a statement that you want to disassociate to Available Statements 
Types box.

5. Select Save to save the changes or Cancel to restore the original values and 
return to the previous screen.

5.3 Viewing a Solution Type
In Oracle’s Knowledge Management, information is organized into solutions, 
segmented into solution types. Knowledge Management is seeded with the 
symptom/cause/action (SCA) solution type. 

Use this procedure to view existing solution types.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
■ CS_KB_KNOWLEDGE_WORKER

■ CS_KB_AGENT

■ CS_KB_SYS_ADMIN

Prerequisites
None

Steps
1. Navigate to Setup > Solution Types. The Solution Types screen displaying a list 

of existing solution types appears.

2. Select the numbered link to navigate to the Solution Type screen for the selected 
solution type to view details about it. You can also update the solution type and 
add/delete statement types or external links to this solution type.

5.4 Updating a Solution Type
Use this procedure to update an existing solution type.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp
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Responsibility
■ CS_KB_SYS_ADMIN

Prerequisites
You must have edit permissions (CS_Type_Edit) to edit a solution type.

Steps
1. Navigate to Setup > Solution Types. Solution Types screen with a list of existing 

solution types appears.

2. Select a Solution Type Number link. The Solution Type screen for that Solution 
Type Number appears.

3. To update the name or description of the Solution Type, enter the new 
information in the appropriate fields. 

4. Select Update.

5. To update the related statements types or external links, make the required 
selections.

6. Select Update to save the changes. Select Restore to return to the original values 
and not save the changes. Select Delete to delete the solution type.

5.5 Deleting a Solution Type
Use this procedure to delete a solution type. You cannot delete the default solution 
type, symptom, cause, action (SCA). You can only delete a solution type if it has not 
been used by any solution. This procedure cannot be undone.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
■ Knowledge Management administrators must have edit permissions (CS_Type_

Edit) to delete a statement type.

■ Delete any statement types associated to this solution type
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Steps
1. Navigate to Setup> Solution Types. The Solution Types screen appears.

2. Select the numbered link of the solution type that you want to delete.

3. In the Solution Type screen, ensure that there are no related statements 
types/external links listed in the Related sub section.

4. To remove related statement types:

a. Select Add/Delete. The Associate Statement Types screen appears. 
Disassociate the statement type from that solution type. 

b. Select Save. Solution Type screen reappears with no statement types or 
external links appearing in the Related section.

5. After removing the related statement types, select Delete.
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6
Managing Statement Types

This chapter includes information about statement types and the tasks associated 
with statement types in Knowledge Management. The sections include:

Section 6.1, "Overview of Managing Statement Types"

Section 6.2, "Creating a Statement Type"

Section 6.3, "Viewing a Statement Type"

Section 6.4, "Updating an Existing Statement Type"

Section 6.5, "Deleting a Statement Type"

6.1 Overview of Managing Statement Types
Statements in Knowledge Management are organized into statement types.

A statement type is an identifying name associated with a particular part of the 
solution type. For example, symptom is a statement type within 
symptom/cause/action solution type.

A statement is a description of any aspect of a problem, its cause, or its resolution. 
Statements can be segmented into statement types. 



Creating a Statement Type

6-2 Oracle Knowledge Management User Guide                              

6.2 Creating a Statement Type

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisite
Knowledge Management administrators with edit permissions (CS_Type_Edit) can 
create a new statement type.

Steps
1. Navigate to Setup > Create Type. The Create Type screen appears.

2. In the Type drop-down list, select Statement.

3. Enter a name for the statement type in the Name field.

4. Enter a description for the statement type in the Description field.

5. Select Create. The Statement Type screen reappears with a Related section. You 
can also relate this statement type to a solution type or external links. To relate 
this statement type to an external link (e.g, a JTF Note Type), perform the 
following steps:

a. In the Related section, select External Links from the drop-down box.

b. Select Add. Select an External Object screen appears. Select Note Type. You 
can relate one statement type to only one note type.

c. The Note Type screen appears. Search for the note type that you want to 
add to this statement type. Use% for wildcard search. 

d. Search results appear. Select the JTF note type that you want to add to the 
statement type. Select Update.
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6.3 Viewing a Statement Type

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
Internal users with view permissions (CS_Statement_View) can view existing 
statement types.

Steps
1. Navigate to Setup> Statement Types. The Statement Types screen appears.

2. Select the numbered link to navigate to the Statement Type screen for the 
selected statement type.

6.4 Updating an Existing Statement Type

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
Knowledge Management administrators with edit permissions (CS_Type_Edit) can 
edit a statement type.

Steps
1. Navigate to Setup> Statement Types. The Statement Types screen appears.

2. Select the numbered link to navigate to the Statement Type screen for the 
selected statement type.

3. Update the name or description of the statement type. 
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4. Select Update.

5. In the Related section, you can add or update the solution types or external 
links.

6. Select Update.

6.5 Deleting a Statement Type
Use this procedure to delete a statement type. You cannot delete the default 
statement type. You can only delete a statement type if it has never been used by 
any statement. This procedure cannot be undone.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites 
■ Knowledge Management administrators with edit permissions (CS_Type_Edit) 

can delete a statement type.

■ Remove a solution type or external link being used by a statement type

Steps
1. Navigate to Setup> Statement Types. The Statement Types screen appears.

2. Select on the numbered link of the statement type that you want to delete.

3. In the Statement Type screen, ensure that there are no related solutions types or 
external links listed in the Related sub section.

4. To remove a solution type or an external link being used by a statement type:

a. In the Remove column, check the check boxes corresponding to the related 
solution types or external links.

b. Select Update.

5. After removing the related solution types or external links, select Delete. 
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7
Managing Categories

This chapter includes information about categories and the tasks associated with 
categories in Knowledge Management. The sections include:

■ Section 7.1, "Overview of Managing Categories"

■ Section 7.2, "Adding Solution Categories"

■ Section 7.3, "Editing Solution Categories"

■ Section 7.4, "Deleting Solution Categories"

7.1 Overview of Managing Categories
Categorization of solutions is the process of segregating solutions into categories for 
browsing or for performing a category-specific search for solutions. Solutions are 
organized into categories for easy management.

Oracle’s Knowledge Management allows manual category definition on its user 
interface. Both product and non-product category listings are supported. Examples 
of product-related categories for a particular company may be databases, software, 
etc. Non-product categories may include services like support agreements, and 
service contracts. Users can define categories based on their business need.

The number of categories is defined by the merchant and may range from none to 
any manageable number. Category types are also defined by the merchant. 

You can select more than one category while creating or modifying a solution and 
while searching for a solution. Category lists can consist of anything that the 
merchant chooses to use for categorization purposes. 

You can browse through solution categories and drill down by category and 
sub-category to narrow search results. Searching for a solution after selecting a 
category will provide more focused results.
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7.2 Adding Solution Categories
You can add solution categories from the Manage Solution Categories screen.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
None

Steps
1. Navigate to Setup> Categories. The Manage Solution Categories screen 

appears.

2. Select the root category or one of the child categories to which you would like 
to add categories by selecting the corresponding radio button.

3. Select the Add button. A new field defaulted as New Category appears.

4. Overwrite the field by entering a new category name in that field.

5. Select Save.

7.3 Editing Solution Categories
You can edit the names of solution categories from the Manage Solution Categories 
screen.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
None



Deleting Solution Categories

                                                                    Managing Categories 7-3

Steps
1. Navigate to Setup> Categories. The Manage Solution Categories screen 

appears.

2. Select the root category or one of the child categories that you want to edit by 
selecting the corresponding radio button.

3. Select the Edit button. The selected category name appears as an editable field.

4. Edit the category name.

5. Select save.

7.4 Deleting Solution Categories
You can delete solution categories from the Manage Solution Categories screen.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
None

Steps
1. Navigate to Setup> Categories. The Manage Solution Categories screen 

appears.

2. Select the category that you want to delete by selecting the corresponding radio 
button.

3. Select the Delete button. The selected category is deleted.
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8
Managing Authoring Flows

This chapter includes an overview about authoring flows and tasks associated with 
authoring flows in Knowledge Management. The sections include:

■ Section 8.1, "Overview of Managing Authoring Flows"

■ Section 8.2, "Creating a New Authoring Flow"

■ Section 8.3, "Viewing Authoring Flows"

8.1 Overview of Managing Authoring Flows
Knowledge Management integration with Oracle Workflow provides a workflow 
process to Knowledge Management internal users to manage the solution approval 
and rejection processes. It is a flexible method for Knowledge Management internal 
users to define solution processing steps that are specific to their needs.

A solution author has an option to either save the solution to his/her own work 
area or to save and submit the solution to an authoring flow for further processing 
in the Solution Detail screen. For more information about workflows, see the latest 
version of Oracle Workflow Guide.

Understanding Solution Authoring Flow in Knowledge Management
A solution authoring flow in Knowledge Management is comprised of a series of 
steps that a solution goes through before reaching a desired state. Each step in the 
authoring flow has a resource group assigned to it for an action to be taken. The 
resource group can be comprised of one or more members. A Knowledge 
Management administrator can define and choose each step of an authoring flow 
and assign a resource group to each step of an authoring flow and, choose an action 
at each step of the flow. Notifications can be sent when each step is completed, to 



Overview of Managing Authoring Flows

8-2 Oracle Knowledge Management User Guide                              

users in a resource group depending on the solution authoring profile of the users. 
The notification is only for information. 

When a solution is submitted to an authoring flow, a copy of the solution remains 
outside the authoring flow for immediate viewing by others and a new copy is 
created for processing within the authoring flow. The authoring flow can be as 
simple as one step such as publish, or it can be as complex as a business requires. 

Example of an Authoring Flow in Knowledge Management
1. An author begins creating a solution in the Solution Detail screen. The solution 

is saved as a work-in-progress solution and has a saved status. It can be seen in 
the Work Pending screen.

2. An author can continue to work on his work-in-progress solution. After 
completing the solution, he can select Save and Submit to Authoring Flow from 
the Solution Detail screen.

3. The Available Authoring Flows screen appears. Select an appropriate workflow 
from the list. Also, select the step to which you want to submit the solution. The 
solution cannot be accessed from the Work Pending screen.

4. The members of the resource group assigned to the authoring flow step that 
you select are notified of the solution to be reviewed. Members who want to 
receive a notification have to subscribe to a category or a product in the 
Solution Authoring Profile screen and the solution has to be related to the 
subscribed product/category.

5. Any member of the resource group, can navigate to the Search Work in Progress 
screen and search for the solution that is ready to be reviewed. After the 
solution is found, a member can select Check-Out to lock the solution. No other 
member can work on this solution until it is back in the authoring flow. 

6. A member can review the solution, make edits, move the solution to the next 
step (to continue the current authoring flow), or reject the solution. 

7. A member can select the next or previous step for the solution. If the solution is 
rejected to an author, then the solution will appear in the Author’s Work 

Note: A system administrator can get the lock for a solution that 
has been locked by another user if the person who had locked the 
solution is no longer available to unlock it and put it back in the 
authoring flow.
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Pending screen and he can check-out the solution, review comments, make 
required edits, and Save and Submit the solution back to the authoring flow.

8. When the solution is submitted to a step whose action is publish, then the 
solution is published.

8.2 Creating a New Authoring Flow
A Knowledge Management administrator can setup an authoring flow. For each 
authoring flow, you can define the following parameters: order, step, assigned to, 
and action.

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
Administrative permissions to create a new authoring flow. 

Steps
1. Navigate to Setup >Authoring Flows. The Available Flows screen appears.

2. Select Create. The Authoring Flow Set Up screen appears.

3. Enter a flow name.

4. For each row, enter an order number, select the Step, Assigned to, and Actions 
fields.

■ Order: defines the sequence of steps in an authoring flow. It is a numbered 
order determining how the steps in a flow will be viewed. For example, a 
step with an order number 1 will be viewed before a step with the order 
number 5.

■ Step: represents the various transitions within an authoring flow. An 
authoring flow can be assigned any of the following steps: Deleted, Draft, 
Editorial Review, Public, Public Internal, Public Limited, Published, 
Technical Review, and Under Edit. You can modify these steps by 
modifying the CS_KB_STATUS lookup type.
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■ Assigned To: represents the resource group that has permissions to check 
out and modify a solution in a specific step of an authoring flow. Each step 
in an authoring flow can be assigned to any of the available user groups 
that have required permissions. For example, Business User Group, 
Editorial Reviewers, Technical Reviewers, etc.

■ Action: represents the action that the Knowledge Management system has 
to take at each step of an authoring flow. An authoring flow can have 
Notify, Obsolete, or Publish actions. These actions imply the following:

a. Notify: a notification is sent to the members of the resource group assigned 
to this step.

b. Obsolete: in Knowledge Management, a flag for the solution is set to 
Obsolete. The solution is still retained in the database, but it is no longer 
visible to any user. A notification is sent to the members of the resource 
group assigned to this step.

c. Publish: in Knowledge Management, a flag for the solution is set to Publish. 
If the distribution for the solution in the Solution Detail screen had been set 
to External, then the solution is visible to external users. A notification is 
sent to the members of the resource group assigned to this step.

5. Select Update.
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8.3 Viewing Authoring Flows
Authoring flows are the steps that a solution goes through in the solution approval 
or rejection processes. 

Login
http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CS_KB_SYS_ADMIN

Prerequisites
Administrative permissions to view (CS_Workflow_Setup_View) a workflow. 

Steps
1. Navigate to Setup >Authoring Flows. The Available Flows screen appears.

2. Select the Authoring Flow name to navigate to the Authoring Flow Set Up 
screen to view details about this flow.

3. On this screen you can modify the Order, Step, Assigned To, and Actions 
parameters for each authoring flow.

4. You can also add a new row of values by selecting the More Rows arrow or 
delete a row by choosing a row and selecting Delete.
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A
Knowledge Management Frequently Asked

Questions

What is Knowledge Management?
Knowledge management is the process by which knowledge is identified, accessed, 
enhanced, and protected through the use of advanced technology, user friendly 
portals, and the development of a culture of openness, sharing, and collaboration.

Knowledge becomes an asset for an organization only when it is available in an 
ordered and accessible format for use by its employees and customers. Knowledge 
can exist in different structured formats such as databases, white papers, 
presentations, etc. 

Knowledge management is designed to prevent duplication of effort, and poor 
decision making due lack of quality information. Knowledge management is also 
designed to improve communication, reduce costs, and to develop competitive 
advantage.

More than eighty percent of incoming customer assistance requests to service 
centers involve issues that have already been resolved. If a knowledge management 
system is not available, a frequently-posed question has to be repeatedly researched 
and relayed by the agent. In this scenario, several costs, both real and in terms of 
customer satisfaction, are incurred. Real costs are associated with the life cycle of 
the problem: customer service representatives must answer the initial customer call, 
log the problem, request more information, escalate the problem, deal with bugs, 
find out if a solution already exists, communicate the fix back to the customer, and 
close the problem. Intangible costs are associated with low customer and agent 
satisfaction. 

A good knowledge management system helps build strong customer relationships 
by enhancing the customer experience with a company’s product or service. A 
knowledge management module is an important part of any complete customer 
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support application. It allows customer support representatives to match the 
problem that they face with the problems that have been previously experienced 
and recorded. Reuse of existing problem descriptions and solutions, improves 
customer service efficiency.

What is the business need of Knowledge Management?
Customer expectations are driving customer service innovations. To meet the 
round-the-clock demands of the Internet, e-commerce sites must provide additional 
personnel to handle customer support needs. Unless you can afford a 24/7 staffed 
call center, you’ll have to make preparations for middle of the night shoppers and 
Internet users in global time zones. 

Knowledge bases are an excellent way to provide information to customers on a 
self-serve basis, particularly for complex services, such as technical support. If your 
visitors are coming to you with questions about installing a new sound card, 
upgrading the BIOS, installing a modem, or cleaning up after a virus, then you’ll 
most likely need more than an FAQ. 

What is Oracle’s Knowledge Management?
Oracle’s Knowledge Management is a solution management and document access 
system that allows customers to search for and resolve their own issues. It has a 
tight integration with other Oracle applications.

Oracle’s Knowledge Management also provides easy solution capture and 
immediate access to new solutions. The relational aspect of Knowledge 
Management provides focused results that relate more directly to the issues being 
researched.

Using natural language queries, customers are able to find immediate and accurate 
solutions to problems and answers to questions, thereby attaining satisfaction 
quickly and increasing your return on investment. Self service support can present a 
viable 24/7 alternative to heavily staffed call centers at a fraction of the cost.

Oracle’s Knowledge Management currently provides solution management to 
Oracle iSupport, Oracle Support, Oracle Field Service, Oracle Depot Repair, and 
Oracle eMail Center. The architecture has been designed to support diverse use and 
is expected to be utilized by other products. 

What is it aimed to do?
Oracle’s Knowledge Management aims to:

■ Reduce support operation costs
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■ Retain profitable customers

■ Address diverse customer needs by providing the information to meet those 
needs

■ Empower customers to help themselves through web self-service 24 x 7

■ Increase customer satisfaction

■ Increase support agent satisfaction and retention

Why is this important?
The phone has been the traditional method for an organization for delivering 
service to its customers. A clear global trend is increasing customer usage of the 
web to receive answers to their questions immediately. Internet enabled self service 
has become the most important trend in customer service because customers can 
get service wherever and whenever they want without waiting in phone queues.

Are there any techniques to help in searching the Knowledge Base 
effectively?
You can use the Advanced Search functionality, or the category headings on the 
Basic Search screen to reduce the number of solutions for your query. A search 
performed by entering a word or a phrase in the Basic Search screen will search the 
entire Knowledge Base. 

Why use Solution Numbers to search on?
 The Solution Number search is the fastest and most direct search method. 

How do I use wild cards in the search query?
Wild cards are especially useful in a search query if you are unsure of the exact 
spelling of a keyword or if you want to do a broad search.

What search method should I use, if I don’t know the Solution Number?
If a Solution Number is not known, then you can use the keyword search. This 
search is not case sensitive. More keywords will result in a narrower search. Enter 
appropriate keywords for quicker and more specific results. 

What is the Theme Search option used for?
Theme search is used to search for a specific phrase. 
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After checking out and locking a solution, how can I check it in, without 
having to submit it to a work flow?
There is currently no way to check in a solution. You have to Save and Submit a 
solution back to a workflow.

How do I publish a statement?
A newly created statement is by default in the draft status. It is published when the 
solution that it is associated with is published. 

What is “Oracle Trading Community”?
Trading Community and Trading Community Architecture (TCA) is an architecture 
designed to support trading communities. The goal of TCA is to provide the 
foundation for Oracle applications. To do this, TCA strives to model all 
relationships within a ‘trading community’. This enables one data model to store 
B2B, B2B2C, B2C and B2C2C data. For example, the trading community of an 
appliance manufacturer may include suppliers, distributors, resellers, retailers, 
service providers, individual consumers and business consumers. The appliance 
manufacturer not only wishes to track relationships between itself and other entities 
within the trading community. The manufacturer may also be interested in 
relationships that other community members have with each other. The appliance 
manufacturer may not even have direct relationships with all the members of its 
trading community. But, it is important that the appliance manufacturer knows 
about these entities and how they relate to other entities within the community. 
Important to point out is that there is only one customer data model/schema, used 
in all Oracle Applications. The 11i Customer Model is not a product that can be 
purchased, Rather, it is the underlying data model that stores customer information 
and is included with any Oracle application. All CRM modules utilize the Customer 
Model to store customer information, although the degree to which the Customer 
Model is utilized differs from module to module.

Does Oracle’s Knowledge Management support different languages
Yes. Oracle’s Knowledge Management is MLS (Multi Lingual Support) compliant 
and supports multiple languages. Users can set the preferences to a language that 
they like to display and this can be changed at any time. For example, customers at 
one particular site can change to a combination of English and Spanish at the same 
site. 
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How is Multi Lingual Support (MLS) used in Knowledge Management?
When you create a solution in one language, a copy of the solution is also created in 
other languages that you have installed. If you assign the publish status to any copy 
of the solution, then the copy of the solution for other languages also gets 
published. You need to make sure that the solution is ready for all the installed 
languages before you assign the publish status to the solution.

How do I customize Oracle’s Knowledge Management?
Oracle JDeveloper can be used for Knowledge Management custom development. It 
can be used to write, debug, deploy, and test Java and JSP applications. You can 
customize menu, roles, permissions, responsibilities and AK prompts. You can also 
customize lookups and profile options. 

Are there options available in the Rapid Installer for Oracle’s Knowledge 
Management?
No

Where are the documents in Knowledge Management stored?
Solutions in Knowledge Management are stored on the main instance where 
Knowledge Management is installed and not on a server.

How are attachments to solutions in Knowledge Management stored?
Both on the database and on the network.

Why can’t I find the solution that I created when I search for them using 
Advanced Search or Basic Search Screens?
To see the new solutions, you have to first run the Knowledge Base Sync index 
concurrent program to refresh the data in the knowledge base.

You also have to check the distribution level. To view restricted solutions, you need 
to have the role with View_Solution_Restricted permission.

While doing a Knowledge Base Search, why can’t I find statements that I 
used in creating a solution. 
The solution that you have created must be in a draft status. You need to publish it 
before the statements in a solution can be searched. 

Draft solutions and statements can be searched by a customer service 
representative, knowledge worker, or a Knowledge Management administrator. 



A-6 Oracle Knowledge Management User Guide                              

People with these roles are allowed permissions to search draft solutions to prevent 
them from creating duplicate solutions. Also, new solutions in a draft status can 
also be used by an agent for assisting customers. 

Publish your solution and run the sync index program again to search both 
published solutions and statements from Basic Search/Advanced Search/Statement 
Search screens. 
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Glossary

Action

An Oracle’s Knowledge Management (Knowledge Management) statement type 
that contains the solution to an issue. It is a part of the Symptom/Cause/Action 
solution type.

Accumulate

This search finds documents that contain at least one of the query terms.

Advanced Search

Advanced Search is a more comprehensive search than Basic Search. You can search 
for solutions under different categories, products, and/or platforms. You can search 
one solution type or all, and search for statements. You can also select an existing 
statement in Knowledge Management and perform a related search.

All Keywords

This search uses the AND operator. The search results must match all terms in the 
query.

Answer

A Knowledge Management statement type that contains the solution to an issue. It 
is a part of the Question/Answer solution type.

Any Keywords

This search uses the OR operator. This search can match one or more query terms. 
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Attachment

A link from a solution to a supporting item of information that enhances the value 
of the solution for its users. Attachments can include graphics, scripts, or 
documents in different file formats.

Authoring Flow

An Authoring Flow defines the steps or tasks that a solution has to follow in the 
solution approval or rejection process.

Basic Search

Basic search is a type of search that allows you to search for a solution based on a 
keyword and/or a category.

Boolean

In this search you can enter your own Intermedia operators. If you do not enter an 
operator, this search performs a phrase search.

Category

A knowledge base collection based on an information attribute such as product or 
version number.

Cause

A Knowledge Management statement type that contains the reason for the solution 
issue. It is a part of the Symptom/Cause/Action solution type.

Dynamic Linking

Is the process of linking an object type or a unique identifier within a statement as a 
link to additional information related to that object type or to that unique identifier.

Fact

A Knowledge Management statement type that contains factual information. 
Examples are product, version number, operating system, etc.

Find Related Statements

The search method that finds all other statements of the same type that have been 
previously linked. The results are displayed based on the strength/weight of the 
link. 
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Find Similar Statements

A text search that finds matches that are determined by comparing keywords to the 
summary of the statements in the repository.

Fuzzy

In this search, the query keywords are expanded into a set of similarly spelled 
keywords, before a search is performed. This search is helpful if there are frequent 
misspellings of the query keyword in the repository. This search will find incorrect 
spellings and synonym matches to the query terms.

Intermedia

Oracle InterMedia is a feature that enables Oracle8i to store, manage, and retrieve 
text, documents, geographic location information, images, audio, and video in an 
integrated fashion with other enterprise information. 

Knowledge Base

The Knowledge Management database that contains information that can be used 
to solve issues.

Knowledge Worker

An individual that creates/edits/technically reviews information within 
Knowledge Management.

Merchant

A company that has purchased or is using one or more Oracle applications.

Problem

A Knowledge Management statement type that contains the issue of a solution 
type, typically part of a Problem/Resolution solution type.

Question

A Knowledge Management statement type that contains the issue. It is a part of a 
Question/Answer solution type.

Relationship

A link between statement types indicating that they have been used together at 
some time as part of a solution. A statement can have many relationships based on 
the number of solutions that it is part of.
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Resolution

A Knowledge Management statement type that contains the solution. It is a part of 
a Problem/Resolution solution type.

Score

Is also known as relevancy threshold. The text search results match (in percentage) 
to the original text query.

Solution

Collection of information or statements to solve an issue or answer a question. 

Solution Number

Every solution in Oracle’s Knowledge Management is associated with a unique 
number. This search will find the solution that is associated with the number 
entered in the search query field. 

Solution Score

Each solution is scored based on the text match performed by InterMedia Text and 
the number of times it has been successfully used to solve issues. These scores are 
shown as a combined score to indicate the strength of the match to the query 
entered. The maximum score is 100. 

Solution Type

Solutions are organized in solution types to make searches more precise and results 
more effective. 

Solved

A button used to indicate that the solution being viewed did solve the users issue

Statement

A statement is a description of any aspect of a problem, its cause, or its resolution. A 
statement has a 500 KB summary field and a 4 GB Detail field. Statements can be 
segmented into statement types.

Statement Type

Statements can be segmented into statement types. It is an identifying name 
associated with a particular part of a solution type. For example, question is a 
statement type in a question/answer solution type.
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Status

Solutions and statements have a status attribute. This attribute describes the phase 
of review that a solution or statement has gone through. Common solution statuses 
are: Draft, Under Edit, Technical Review, Editorial Review, Obsolete, and Published.

Symptom

A Knowledge Management statement type that contains the issue the user is trying 
to solve. It is a part of the Symptom/Cause/Action solution type.

Theme

This search is also called an about search in Intermedia. Intermedia categorizes the 
documents in its repository into themes, based on their textual content. When this 
search is performed, the query keywords are compared with the theme index. 
Documents having the same themes as the keywords appear in the result list.

User

A Knowledge Management user can be an internal or an external user. External 
users are users that can see published solutions. Internal users include system 
administrators, knowledge workers, and knowledge agents. 

Weight

A number that indicates the number of times a statement has been used with other 
statements to solve an issue

Workflow

Oracle Workflow provides a workflow process to Knowledge Management for 
solution approval and rejection processes. It is a flexible method for Knowledge 
Management users to define solution authoring flow steps that are specific to their 
needs.
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